BOOK TEMPLATES FOR WORD pdf
1: Self Publishing, Book Printing - Free Book Templates
We offer templates for use with the following design programs: Adobe InDesign, QuarkXPress, and Microsoft Word All
text files must be in our design templates. All files and images should be high resolution ( PPI) and converted to CMYK
color.

Select "Whole Document" under Apply To. Switch over to the Paper tab. Adjust the height and width to match
the paper size your book will be printed in. Select "OK" to save the changes. Setting up Bleeds for Your
Interior Book Template If you want the interior pages to bleed where the artwork goes right to the edge of the
paper and are using Microsoft Word, or any other word processing program, you will need to add. If you want
a 5. We will trim off. Also remember to select Mirror Margins, when setting up your custom page size in
Microsoft Word. If you are using Microsoft Word, or any other word processing program, it can be very
difficult to set up bleeds correctly and have everything line up evenly throughout the interior of the book. We
suggest using a more robust piece of software like Adobe InDesign. Adobe does offer a free trial for 30 days,
and has monthly plans as well. If you are using a page layout program like Adobe InDesign, and want certain
pages to bleed, you will need to include the bleeds and crop marks when you export your file as a PDF file.
Adobe offers a great help section on how to set-up your document with bleeds using InDesign. This setting
will alert you to any low resolution images and embed all of your fonts as well. Font Embedding is when all
the font information is captured from your computer and stored inside the PDF file. Why is Font Embedding
so Important? If the fonts are not embedded in your PDF files, the type can reflow and become distorted. Even
common Fonts like Times need to be embedded, because what we have found is there are many different
versions of the Common Fonts. The good news is that embedding Fonts is quite Easy. Mac computers will
automatically Embed the fonts, so no need to worry about embedding the fonts. Can I send in the Cover and
Text in the same file? If the Cover artwork is part of the Text file, it will mess up the Margins of the Text,
after the Cover is extracted. Please review our Cover Template for details on how to set up the Book Cover. If
PDF book files are supplied as 8. Reducing the file size is not recommended, because it will make the type
small and hard to read. DiggyPOD has a Video Tutorial at the top of this page, that will show you how you
set-up your files to the correct trim size. Page numbers on the binding side of the Book Text File We
recommend that your page numbers, header, or footers are not on the binding side of the book. A easy way to
avoid this common book printing problem is to have your page numbers, headers, or footers at the bottom
center of the book. If you are still unsure, just simply print out two pages that are front and back and place
them back to back to see if everything is okay. Can I send in a new file, if I find mistakes when proofing? We
put a lot of work and time into quality checking each file, and when you send a new file, we have to start the
process again from the beginning. What if there are issues with my files? Can you fix them? Most of the time,
we can fix most common issues with your files. You can choose this option when you place your order, and if
there are any common issues with the files, we will fix them. We will also let you know what issues we fixed
when we upload the online proof for your approval. If you have to send in new files that we cannot fix. Do I
count the blank pages in the files as pages? Blank pages are counted as a page, we will not remove any blank
pages. If you send the Word file to us, it will reflow and cause all sorts of formatting issues. Will I see a proof
before you print my order? All new orders get an online proof of the Book Cover and Text file before we go to
print. You can also order a hard copy proof when placing your order. The online proof is free, but the hard
copy proof is an extra fee. All of your Videos are for Microsoft Word, can I use a different program? We also
have quite a few customers that use Adobe Creative Suite. Some common programs that we recommend to
avoid using are: Powerpoint, Paint, and any other program that saves items in low resolution. We also
recommend not to use any graphics from websites, as most graphics on websites are only 72 dpi, and print in
low resolution. This setting will automatically embed your fonts, and alert you if there are any low resolution
graphics. If you have any questions about our book templates or need additional assistance, please call us at A
real person always answers the phone during business hours.
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2: Create a booklet using a template in Word for Mac - Word for Mac
This accessible booklet template makes it easy to personalize a simple booklet to help you market your company.
Follow the tips in the template to create a professional looking booklet. Change the look by using the built-in themes on
the Design tab of the ribbon.

Does your manuscript contain images or graphics that "bleed" to the edge of the page? For example, if your
trim size is 6" x 9", set the page size to 6. To change the page size: In the "Page Setup" section of the Layout
tab, click Size. Select More Paper Sizes. This will open a dialog box. In the "Preview" section, select Whole
document from the "Apply to" dropdown menu. This will resize your pages and change your page count. Trim
size without bleed 5" x 8" Customize front matter Tips for formatting your front matter: If you copy content
from another document and paste it into the template, the formatting may transfer and need to be corrected. If
you do add it, make sure it matches the number assigned to your book. If you add the number, format it like
this: Add the page numbers later. When you insert your book content into the chapters, the page numbers will
shift. Go to the Home tab in Word. This will help you see where section breaks begin. Highlight the
placeholder text in the section you want to remove. Hit the Delete key. Place your cursor in front of the
Section Break marker. Customize chapter pages Tips for formatting your chapter pages: As a first step, we
recommend that you update the template to include the numbers of chapters you want. Highlight and copy the
last chapter. Put your cursor at the end of the last chapter. Hit the Enter key. Put your cursor at end of the
second to last chapter. Go to the Insert tab. In the "Pages" section, click Page Break. Hit the Enter key to insert
space above the last chapter title. Not sure how much space to insert? See the other chapters to compare.
Deleting chapters Highlight the chapter you want to delete and hit the Backspace key. After you add or delete
chapters, update the headers. To replace the placeholder text for the book title odd pages and author name
even pages with your information: Double-click on the header. Highlight the placeholder text and hit the
Delete key. Add your information, including additional formatting e. Make sure the title and author name
match exactly what you enter during title setup. Double-click on the chapter text to leave the header. Again, if
you copy content from another document and paste it into the template, the formatting may transfer and need
to be corrected. If there is, customize or remove it. If you want to keep it, customize it; if not, remember to
remove it.
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3: Book Cover Templates â€“ Download Formats and Designs for Word & PDF
Create a booklet or book On the PAGE LAYOUT tab, click the icon at the bottom-right corner of the Page Setup group to
pop out the Page Setup window. On the Margins tab, under Pages, change the setting for Multiple pages into Book fold.

Read on to learn everything you need to know about how to make your own book covers before publication.
This page explains what you need to know about: Yes, they need to be two separate files. An image is often a
central feature of any cover. The image must be engaging and represent your book, of course, but it also must
be crisp and clear. A printed image must have a certain resolution or the image will be pixelated and blurry.
Your cover image should be at least DPI for the best quality printing. The best resolution is DPI. Please watch
the book cover resolution tutorial video below, to find the DPI of an image or graphic that you want to use for
your front and back covers. Download the correct template for the correct trim size of your book. We will try
to use the same fonts or very closely matched fonts as those used on the cover. If you want anything different,
we ask that you specify in the "Additional Comments" when ordering and we will take care of your request.
Note that books under 70 pages are too thin to have a spine. Most graphic artists use Adobe InDesign, and will
send us one file for the cover that has the front, back, and the spine all merged into one layout file that is ready
to print. Our spine calculator is for advanced users of page layout programs. We highly recommend
self-publishers use our Free Book Spine Creation service. Then, DiggyPOD will marry the files together and
add the spine information for you! DiggyPOD will create a barcode and place it on the back cover of your
book for you. Please remember to leave 2" wide x 1. Custom Cover Layout Requirements If you want a
custom size that is not listed in our templates, then you will need to create your own template. If you want a
final book trim size of 5. You will have to make your Word document page size 5. You will need to adjust
your margins to. If you want your images to bleed where images or graphics go right to the trim edge , then
you must add. For a custom size cover with a final trim of 5. Font embedding is when all the font information
is captured from your computer and stored inside the PDF file. Why is font embedding so important? If the
fonts are not embedded in the PDF file, the type can reflow and become distorted. Even common fonts, like
Times, need to be embedded because there are many different versions of common fonts. The good news is
that embedding fonts in your cover file is quite easy. We have an easy-to-follow video tutorial that will show
you how to do it. Just click here to watch the video. Mac computers embed the fonts automatically. How do I
know if my images and graphics are high resolution? Click here to see the difference between a high
resolution image and low resolution image. In our experience, you may want to avoid getting artwork for your
cover from websites and image searches, as images on websites are only 72 DPI and print very poorly. But, if
you are happy with the quality of the images at low resolution, we can print them. DiggyPOD is very quality
oriented, and we want to make sure you get the best quality book printing possible. What is the recommend
DPI of images and graphics? When you place your order, you can add your ISBN number by choosing our
Create Barcode option under additional services. Please remember to leave an area of 1. How do you know
what type to put on the spine? If you want something different, just specify in the additional comments area
when ordering and we will take care of it for you. How many pages must my book be to have type on the
spine? About 70 pages is the minimum page count to have any type on the spine. Give us a call at so we can
answer any questions you have.
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4: Address Book Word Templates Design, Download now | www.enganchecubano.com
This is a guide to formatting your book in Microsoft Word (). We'll be making a 6"x9" PDF for print; but you can easily
change the document to another size.

Global Address Book Third part Address Book Using address book keeps you very convenient in contacting
the person you require for any purpose. You cannot remember names, addresses and numbers of all people
related to your personal as well as professional life. Address books are kept in home, offices, pockets, shops
and everywhere when you have to contact with people. Address book can be said a personal information
manager that keeps list of contacts with names, addresses and numbers. Here is download link, Importance of
Address Book Templates It is very necessary to have a well drafted and well managed address book to stay
convenient in contacting with desired people. For making your address book more authentic, you should
follow the tips given below: First of all, you must categorize the people before writing them on address book.
Personal and professional contacts should be written separately to avoid irritation. Sometimes, names of
contacts are similar and you find it difficult to contact with the right person at that time. So making categories
of contacts is most suitable to make address book more convenient and useful. Contacts should be written in
an order in address book. It is most suitable if you write contacts in alphabetical order in address book. This
will let you find the right person at that time. Your address book also looks clean and neat when you write
everything in an order. How an address book can be beneficial if you write names and other details of contacts
on separate places in address book? You should write all necessary details with just each contact not anywhere
else in address book or other pages of address book. This thing will be very wrong in finding the right contact
details. Address, phone numbers, fax numbers and email addresses should be written with each contact.
Special people should be given a special place at address book when you enter their names and other contact
details. These may be some of your special friends and family contacts that you should keep separate in
address book. It would also be better to easily find them in address book. These tips are necessary to make a
good and useful address book for your personal as well as professional uses.
5: 10+ Free Download Book Templates MS Word Format | Free & Premium Templates
2. Scroll through the templates. Although Word probably won't have your bestseller-to-be template theme, choose a
template that best suits your book requirements.

6: Paperback Manuscript Templates | Amazon Kindle Direct Publishing
Using our Free Book Templates for Self Publishing Here is a very short video (less than a minute and a half) that gives
you a quick explanation of how to use our free book design templates for your inside pages.

7: Create a booklet or book - Word
Beautifully designed book formatting templates, perfect for YOUR project. Sign up for easy-to-use book formatting
templates in Word and InDesign, and a guided video course to help you format like a pro without wasting valuable time.

8: Do It Yourself Book Layout With MS Word
Articles & Tips Do-It-Yourself Book Layout (With Microsoft Word) The advent of the word processor has opened doors to
the average author that could only be imagined not more than a decade ago.

9: Book Cover Template | Free MS Word Cover Templates
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> Types of Book Templates. The book word format templates could be many and varied as these look to address the
various facets of the book. Some of the most popular downloadable book word templates are discussed here.
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